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Chapter 1: ANSYS POLYFLOW in ANSYS Workbench Tutorial: 3D

Extrusion

1.1. Introduction

This tutorial illustrates how to use ANSYS POLYFLOW fluid flow systems in ANSYS Workbench to set up

and solve a 3D extrusion problem with a variety of inlet flow rates. This tutorial is designed to introduce

you to the ANSYS Workbench tool set using the same geometry that is used in Tutorial 6 in the separate

Tutorial Guide. In this tutorial, you will import the geometry and generate a computational mesh using

the geometry and meshing tools within ANSYS Workbench. Then you will use ANSYS POLYDATA to

modify an imported data file, solve the CFD problem using ANSYS POLYFLOW, and view the results in

the CFD-Post postprocessing tool. Finally, you will use the Parameter and Design Points view in ANSYS

Workbench to calculate results for multiple design points that represent different inlet flow rates.

This tutorial demonstrates how to do the following:

• Launch ANSYS Workbench.

• Create an ANSYS POLYFLOW fluid flow analysis system in ANSYS Workbench.

• Import and edit geometry using ANSYS DesignModeler.

• Create a computational mesh for the geometry using the ANSYS Meshing application.

• Import a data file, and modify it using ANSYS POLYDATA to include a user-defined template for the die

inlet flow rate.

• Calculate a solution using ANSYS POLYFLOW.

• View the initial results and create an output parameter for the maximum velocity of the extrudate in

CFD-Post.

• Generate results for multiple design points using the Parameter and Design Points view, and chart

how the outflow velocity varies with the inlet flow rate.

1.2. Prerequisites

This tutorial assumes that you have little to no experience with ANSYS DesignModeler, ANSYS Meshing,

ANSYS POLYFLOW, CFD-Post, or the Parameter and Design Points view of ANSYS Workbench, and so

each step will be explicitly described.

1.3. Problem Description

This problem deals with the flow of a Newtonian fluid through a three-dimensional die. Due to the

symmetry of the problem (the cross-section of the die is a square), the computational domain is defined

for a quarter of the geometry and two planes of symmetry are defined.

The melt enters the die as shown in Figure 1.1 (p. 2) at an initial flow rate of =�  cm
3
/s (this flow

rate is a quarter of that for the complete physical system) and the extrudate is obtained at the exit. It

is assumed that the extrudate is fully deformed at the end of the computational domain, and that it

1
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will not deform any further (i.e., subdomain 2 is long enough to account for all the deformation of the

extrudate).

Figure 1.1  Problem Description

The incompressibility and momentum equations are solved over the computational domain. The domain

for the problem is divided into two subdomains (as shown in Figure 1.1 (p. 2)) so that a remeshing

algorithm can be applied only to the portion of the mesh that will be deformed. Subdomain 1 represents

the die where the fluid is confined. Subdomain 2 corresponds to the extrudate that is in contact with

the air and can deform freely. The calculation will determine the location of the free surface (the skin

of the extrudate), as well as the velocity of the extrudate at the exit.

The boundary set for the problem is shown in Figure 1.2 (p. 3), and the conditions at the boundaries

of the domains are:

• inlet: flow inlet, initial volumetric flow rate =�  cm
3
/s

• die wall: zero velocity

• free surface: free surface

• symmetry 1: symmetry plane

• symmetry 2: symmetry plane

• outlet: flow exit

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
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Figure 1.2  The Boundary Set for the Problem

1.4. Setup and Solution

1.4.1. Preparation

1. Copy the file ext3d-workbench.zip to your working directory. To access this file, begin by pointing

your web browser to

• For Windows:

path\ANSYS Inc\v140\polyflow\polyflow14.0.�\help\index.htm

• For Linux:

path/ansys_inc/v140/polyflow/polyflow14.0.�/help/index.htm

where path is the directory in which ANSYS POLYFLOW has been installed and � represents the

appropriate number for the release (e.g., 0 for polyflow14.0.0).

If, for example, you are using Internet Explorer as your browser, select the File > Open... menu

item and click the Browse button to browse through your directories to find the file.

When opened, the file displays the ANSYS POLYFLOW documentation “home" page. Click the

Download link under the ANSYS POLYFLOW in ANSYS Workbench Tutorial heading, and then

copy the ext3d-workbench.zip file that is saved to your computer to your working directory.

2. Unzip ext3d-workbench.zip.

3
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The geometry file ext3d.x_t and the data file polyflow.dat can be found in the ext3d-
workbench folder created after unzipping the file. Solution files created during the preparation of

the tutorial are provided in a solution_files folder.

Note

This tutorial is prepared using ANSYS POLYFLOW on a Windows system. The screen shots

and graphic images that follow may be slightly different than the appearance on your system,

depending on the operating system or graphics card.

1.4.2. Step 1: Creating a Fluid Flow Analysis System in ANSYS Workbench

In this step, you will start ANSYS Workbench, create a new fluid flow analysis system, then view the list

of files generated by ANSYS Workbench.

1. Start ANSYS Workbench by clicking the Start button, moving your pointer over All Programs, moving

your pointer over ANSYS 14.0, then clicking Workbench 14.0.

Start → All Programs → ANSYS 14.0 → Workbench 14.0

The ANSYS Workbench application window will open, containing the Toolbox on the left and the

Project Schematic on the right. Various supported analyses and applications are listed in the Toolbox,

while you visualize the components of the analysis in the Project Schematic.

Note

When you first start ANSYS Workbench, the Getting Started pop-up window is dis-

played, offering assistance through the online help for using the application. You can

keep the window open, or close it by clicking the red ‘X’ icon in the upper right corner.

If you need to access the online help at any time, use the Help menu, or press the F1

key.

2. Create a new fluid flow analysis system by double-clicking the Fluid Flow (POLYFLOW) option under

Analysis Systems in the Toolbox.

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
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Figure 1.3  Selecting the Fluid Flow (POLYFLOW) Analysis System in ANSYS Workbench
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Extra

You can also create a new fluid flow analysis system by dragging-and-dropping the

analysis system into the Project Schematic: a green dotted outline will indicate a po-

tential location in the Project Schematic for the new system, which will turn into a red

box when you attempt to drop it.

A new ANSYS POLYFLOW-based fluid flow analysis system will be displayed in the Project Schematic.

Figure 1.4  ANSYS Workbench with a New ANSYS POLYFLOW-Based Fluid Flow Analysis

System

Note

The ANSYS POLYFLOW-based fluid flow analysis system, for example, is composed of

various cells (Geometry, Mesh, etc.) that represent the work flow for performing the

analysis. ANSYS Workbench is composed of multiple data-integrated (e.g., ANSYS

POLYFLOW) and native applications into a single, seamless project flow, where individual

cells can obtain data from and provide data to other cells. ANSYS Workbench provides

visual indications of a cell’s state at any given time via icons on the right side of each

cell. Because of the constant flow of data, a cell’s state can quickly change. Brief descrip-

tions of the various states are provided below. For more information about cell states,

see the ANSYS Workbench online help.

• Unfulfilled ( ) indicates that required upstream data does not exist. For example, when you first

create a new Fluid Flow (POLYFLOW) analysis system, all cells downstream of the Geometry cell

appear as Unfulfilled because you have not yet specified a geometry for the system.

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
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• Refresh Required ( ) indicates that upstream data has changed since the last refresh or update.

For example, after you assign a geometry to the Geometry cell in your new Fluid Flow (POLYFLOW)

analysis system, the Mesh cell appears as Refresh Required since the geometry data has not yet

been passed from the Geometry cell to the Mesh cell.

• Attention Required ( ) indicates that the current upstream data has been passed to the cell,

however, you must take some action to proceed. For example, after you launch ANSYS POLY-

DATA from the Setup cell in a Fluid Flow (POLYFLOW) analysis system that has a valid mesh, the

Setup cell appears as Attention Required because additional data must be entered in ANSYS

POLYDATA before you can calculate a solution.

• Update Required ( ) indicates that local data has changed and the output of the cell needs to

be regenerated. For example, after you launch ANSYS Meshing from the Mesh cell in a Fluid Flow

(POLYFLOW) analysis system that has a valid geometry, the Mesh cell appears as Update Required

because the Mesh cell has all the data it needs to generate an ANSYS POLYFLOW mesh file, but

the ANSYS POLYFLOW mesh file has not yet been generated.

• Up-to-Date ( ) indicates that an update has been performed on the cell and no failures have

occurred (or an interactive calculation has been completed successfully). For example, after ANSYS

POLYFLOW finishes performing the number of necessary solver iterations, the Solution cell appears

as Up-to-Date.

• Interrupted ( ) indicates that you have interrupted an update (or stopped an interactive calculation

that is in progress). For example, if you select the stop button ( ) in the Progress Monitor of ANSYS

Workbench at a point where ANSYS POLYFLOW has generated results but has not yet completed

the calculation (such as during a transient simulation), then verify the action in the dialog box that

opens, ANSYS POLYFLOW is immediately stopped and the Solution cell appears as Interrupted.

• Input Changes Pending ( ) indicates that the cell is locally up-to-date, but may change when

next updated as a result of changes made to upstream cells. For example, if you change the Mesh

in an Up-to-Date Fluid Flow (POLYFLOW) analysis system, the Setup cell appears as Refresh

Required, and the Solution and Results cells appear as Input Changes Pending.

• Pending ( ) indicates that a batch or asynchronous solution is in progress. This icon will only

appear when the Solution cell is in background mode.

• Refresh Failed, Refresh Required ( ) indicates that the last attempt to refresh cell input data

failed, and so the cell needs to be refreshed.

• Update Failed, Update Required ( ) indicates that the last attempt to update the cell and calculate

output data failed, and so the cell needs to be updated. For example, if you update the Solution

cell and the solver diverges during the calculation, the Solution cell appears as Update Failed,

Update Required.

• Update Failed, Attention Required ( ) indicates that the last attempt to update the cell and

calculate output data failed, and so the cell requires attention.

3. Name the analysis.

a. Double-click the Fluid Flow (POLYFLOW) label underneath the analysis system.

b. Enter ext3d for the name of the analysis system.

4. Save the project.

a. Select the Save option under the File menu in ANSYS Workbench.

7
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File → Save

The Save As dialog will open, where you can browse to a specific directory and enter a specific

name for the ANSYS Workbench project.

b. In your working directory, enter ext3d-wb as the project File name and click the Save button

to save the project. ANSYS Workbench saves the project with a .wbpj extension, as well as sup-

porting files for the project.

5. View the files generated by ANSYS Workbench, by enabling the Files option under the View menu.

View → Files

The Files view will be displayed in the Project Schematic.

Figure 1.5  Displaying the Files View after Adding an ANSYS POLYFLOW-Based Fluid

Flow Analysis System

ANSYS Workbench allows you to easily view the files associated with your project using the Files view.

You can see the name and type of file, the ID of the cell the file is associated with, the size of the file,

the location of the file, and other information. For more information about the Files view, see the

separate ANSYS POLYFLOW in Workbench User’s Guide and the ANSYS Workbench online help.

1.4.3. Step 2: Preparing the Geometry in ANSYS DesignModeler

In this step, you will import a previously created geometry file, modify the geometry with ANSYS

DesignModeler, then review the list of files generated by ANSYS Workbench.

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
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Note

ANSYS DesignModeler is licensed separately from ANSYS POLYFLOW. If you do not have access

to ANSYS DesignModeler, you can instead import a geometry file that does not need to be

modified, as noted in step 1.c.

1. Import the geometry file.

a. Right-click the Geometry cell in the ext3d fluid flow analysis system (cell A2 in the ANSYS

Workbench  Project Schematic).

b. Move your pointer over Import Geometry in the context menu that opens, and click Browse....

c. Use the Open dialog box to browse to the ext3d-workbench folder you unzipped in a previous

step, select ext3d.x_t, and click Open.

Note

If you do not have access to ANSYS DesignModeler, select PFL.agdb in the Open

dialog box instead, then skip to Step 3: Meshing the Geometry in the ANSYS Mesh-

ing Application (p. 11).

The state of the Geometry cell becomes Up-to-Date, indicating that there is a geometry now associated

with the fluid flow analysis system.

2. Start ANSYS DesignModeler.

Double-click the Geometry cell in the ext3d fluid flow analysis system to launch the ANSYS

DesignModeler application.

Extra

You can also launch ANSYS DesignModeler by right-clicking on the Geometry cell to

display the context menu then selecting the Edit Geometry... option.

3. Set the units in ANSYS DesignModeler.

When ANSYS DesignModeler first opens, you are prompted to select the desired system of length

units to work from. For the purposes of this tutorial, select Centimeter as the desired length unit

and click OK to close the prompt.

9
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4. Finish importing the geometry file by clicking Generate in the ANSYS DesignModeler toolbar. The

geometry will be displayed in the Graphics window.

Figure 1.6  The Imported Geometry in the ANSYS DesignModeler Application

5. Modify the geometry so that the separate domains ("bodies") are treated as a single entity (a "part"),

by performing the following actions in the Tree Outline.

By uniting the multiple bodies of the geometry into a single part, you will create a conformal mesh

between the separate domains of the bodies.

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
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a. Expand the 2 Parts, 2 Bodies node.

b. Click 1 so that it is highlighted.

c. Hold the Ctrl key and click 2 so that it is highlighted as well.

d. Right-click the highlighted objects and click Form New Part in the menu that opens.

The Tree Outline will list the geometry as 1 Part, 2 Bodies.

6. Close ANSYS DesignModeler.

You can simply close the ANSYS DesignModeler application. ANSYS Workbench automatically

saves the geometry and updates the Project Schematic accordingly.

7. View the files generated by ANSYS Workbench, as displayed in the Project Schematic.

Note the addition of the geometry file (PFL.agdb, where PFL indicates a POLYFLOW-based fluid

flow system) to the list of files.

1.4.4. Step 3: Meshing the Geometry in the ANSYS Meshing Application

Now that you have prepared the extrusion geometry, you need to generate a computational mesh

throughout the flow volume. In this step, you will use the ANSYS Meshing application to create a mesh

for your CFD analysis, then review the list of files generated by ANSYS Workbench.

1. Open the ANSYS Meshing application.

Double-click the Mesh cell in the ext3d fluid flow analysis system (cell A3) to launch the ANSYS

Meshing application with the extrusion geometry already loaded.

Extra

You can also right-click the Mesh cell to display the context menu where you can select

the Edit... option.
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Figure 1.7  The ANSYS Meshing Application with the Extrusion Geometry Loaded

2. Group the faces and create named selections to match the boundary set shown in Figure 1.2 (p. 3).

a. Rotate the view to get your display similar to that shown in Figure 1.8 (p. 13), by holding the

center mouse button and moving your pointer in the geometry window.

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
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Figure 1.8  Rotated View

b. Click Mesh under Project/Model in the Outline tree.

Information will be displayed about the mesh in the Details view below the Outline tree view.

Note

Note that since the ANSYS Meshing application automatically detects that you are

going to perform a CFD fluid flow analysis using ANSYS POLYFLOW, the Physics

Preference will already be set to CFD and the Solver Preference will already be

set to POLYFLOW.

c. Select the face that will represent the inlet, as shown highlighted in green in Figure 1.9 (p. 14).

d. Right-click and select the Create Named Selection option (from the menu that opens) to open

the Selection Name dialog box.

13
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Figure 1.9  Selecting the Inlet Face

e. Enter inlet for the name in the Selection Name dialog box, and click OK.

f. Hold down the Ctrl key, select the 2 faces that will represent the zero velocity boundary (as

highlighted in green in Figure 1.10 (p. 15)), then create a selection named die wall in a manner

similar to the previous steps.

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
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Figure 1.10  The Zero Velocity Faces Selected

g. Hold down the Ctrl key, select the 2 faces that will represent the free surface boundary (as high-

lighted in green in Figure 1.11 (p. 16)), and create a selection named free surface in a manner

similar to the previous steps.

15
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Figure 1.11  The Free Surface Faces Selected

h. Rotate the view to get your display to be similar to that shown in Figure 1.12 (p. 17), by holding

the center mouse button and moving your pointer in the geometry window.

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
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Figure 1.12  Rotated View

i. Hold down the Ctrl key, select the 2 faces that will represent one of the symmetry boundaries

(as highlighted in green in Figure 1.13 (p. 18)), and create a selection named symmetry 1 in a

manner similar to the previous steps.

17
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Figure 1.13  The First Pair of Symmetry Faces Selected

j. Hold down the Ctrl key, select the 2 faces that will represent the other of the symmetry boundaries

(as highlighted in green in Figure 1.14 (p. 19)), and create a selection named symmetry 2 in a

manner similar to the previous steps.
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Figure 1.14  The Second Pair of Symmetry Faces Selected

k. Select the face that will represent the flow exit boundary (as highlighted in green in Figure

1.15 (p. 20)), and create a selection named outlet in a manner similar to the previous steps.

19
Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



Figure 1.15  The Flow Exit Face Selected

3. Set the appropriate meshing parameters for the ANSYS Meshing application.

a. Expand the Sizing node in the Details view to reveal additional sizing parameters.

b. Select Off from the Use Advanced Size Function drop-down list.

4. Generate the mesh.

a. Right-click Mesh in the Outline tree view, and select Update in the context menu.

The geometry window will display the generated mesh.

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
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Note

Using the Generate Mesh option from the Mesh context menu creates the mesh,

but does not actually create the relevant mesh files for the project and is optional

if you already know that the mesh is acceptable. Using the Update option auto-

matically generates the mesh and creates the relevant mesh files for your project

and updates the ANSYS Workbench cell that references this mesh.

b. Refine the mesh.

i. Enter 80 for Relevance under Defaults in the Details view.

ii. Right-click Mesh in the Outline tree view, and select Update in the context menu.

The geometry window will display the refined mesh.

Extra

After the mesh is generated, you can view the mesh statistics by expanding the Stat-

istics node in the Details view to reveal information about the number of nodes, the

number of elements, and other details.
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Figure 1.16  The Computational Mesh for the Extrusion Geometry

5. Close the ANSYS Meshing application.

When you close the ANSYS Meshing application, ANSYS Workbench automatically saves the mesh

and updates the Project Schematic accordingly (the state of the Mesh cell changes from Refresh

Required to Up-to-Date, indicating that there is a mesh now associated with the fluid flow ana-

lysis system).

6. View the files generated by ANSYS Workbench, as displayed in the Project Schematic.
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Note the addition of the mesh files (PFL.1.poly and PFL.mshdb) to the list of files. The

PFL.1.poly file was created when you updated the mesh, and the PFL.mshdb file was generated

when you closed the ANSYS Meshing application.

1.4.5. Step 4: Setting Up the CFD Simulation in ANSYS POLYDATA

In this step, you will proceed to set up a CFD analysis using ANSYS POLYDATA, then review the list of

files generated by ANSYS Workbench.

1. Import the data file (polyflow.dat).

The data file you will import has already been set up for a 3D extrusion simulation with a single inlet

flow rate. For details on how to set up a similar data file in ANSYS POLYDATA, see Tutorial 6 in the

separate Tutorial Guide.

a. Right-click the Setup cell in the ext3d fluid flow analysis system, and click Import POLYFLOW

Dat ... in the context menu that opens.

b. Use the Open dialog box to browse to the ext3d-workbench folder you unzipped in a previous

step, select polyflow.dat, and click Open.

The state of the Setup cell remains Refresh Required, indicating that even though there is a

data file now associated with the fluid flow analysis system, you still must perform an update for

the cell.

c. Right-click on the Setup cell and click Update in the context menu that opens.

After ANSYS POLYDATA converts the .poly mesh file into a .msh file and checks for coherence

between the mesh and data files, the state for the Setup cell becomes Up-to-Date. At this point

it would be possible to run the ANSYS POLYFLOW solver for your simulation; however, for this

tutorial you will first modify the data file.

2. View the files generated by ANSYS Workbench, as displayed in the Project Schematic.

Note the addition of the mesh file (convert.msh) and the data file (polyflow.dat) to the list of

files.

3. Start ANSYS POLYDATA.
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Double-click the Setup cell in the ext3d fluid flow analysis system.

Extra

You can also launch ANSYS POLYDATA by right-clicking on the Setup cell and clicking

Edit... in the context menu that opens.

Note

The mesh is automatically loaded and displayed in the Graphics Display window by

default.

Figure 1.17  The ANSYS POLYDATA Application
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4. Modify the data file so that the inlet flow rate is flagged as modifiable in a user-defined template

(UDT).

Note

UDTs are considered input parameters by ANSYS Workbench.

a. Click F.E.M. Task 1 in the main POLYDATA menu.

F.E.M. Task 1

b. Click 3D die swell (which is the name that was given to the sub-task for the flow problem when

the data file was created) in the F.E.M. Task 1 menu.

3D die swell

c. Click Flow boundary conditions in the 3D die swell menu.

Flow boundary conditions

d. Select Inflow along INLET in the Flow boundary conditions menu and click Modify.

e. Click the UPDT button at the top of the ANSYS POLYDATA application window, to enable template

inputs.

f. Click Inflow in the Flow boundary condition along INLET menu.

Inflow

g. Retain the selections of Automatic and Volumetric flow rate in the Inflow calculation on INLET

menu, and note that the flow rate is already set to 10. Then click Upper level menu.

h. Click Create a new template entry in the Create template entry menu.

Create a new template entry

i. Click the UPDT button again at the top of the ANSYS POLYDATA application window, to disable

template inputs.

j. Click Upper level menu repeatedly to return to the main POLYDATA menu.

5. Save the data file and close ANSYS POLYDATA.

a. Click Save and exit in the main POLYDATA menu.

Save and exit

b. Click Accept in the Field Management menu.

Accept

c. Click Continue.

Continue
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The Parameters cell will be added to the ext3d fluid flow analysis system in the ANSYS Workbench 

Project Schematic (cell A7). Also, a Parameter Set bar will be added below the system with an in-

bound arrow, indicating that an input parameter has been created.

6. View the files generated by ANSYS Workbench, as displayed in the Project Schematic.

Note the addition of the template file (templates.upd) to the list of files.

1.4.6. Step 5: Running the CFD Simulation in ANSYS POLYFLOW

Now that your mesh and data files are properly set up, in this step you will use the ANSYS POLYFLOW solv-

er to run the initial simulation, generate results files, then review the list of files generated by ANSYS

Workbench.

1. Start ANSYS POLYFLOW.

In the ANSYS Workbench  Project Schematic, right-click the Solution cell in the ext3d fluid flow

analysis system (cell A5), and click Update in the context menu that opens.

The ANSYS POLYFLOW solver will begin running. When the calculation is complete, the state for the

Solution cell becomes Up-to-Date.

2. View the files generated by ANSYS Workbench, as displayed in the Project Schematic.
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Note the addition of the listing file (polyflow.lst), the ANSYS POLYFLOW results file (res), the

output mesh file (res.msh), and the CFD-Post file (cfx.res) to the list of files. For more information

about ANSYS POLYFLOW (and the files associated with it), see the ANSYS POLYFLOW 14.0 User’s Guide.

1.4.7. Step 6: Displaying Results in ANSYS CFD-Post

In this step, you will use ANSYS CFD-Post to view the results of your initial simulation, create an expression

that can be used as an output parameter for ANSYS Workbench, then review the list of files generated

by ANSYS Workbench.

1. Start ANSYS CFD-Post.

In the ANSYS Workbench  Project Schematic, double-click the Results cell in the ext3d fluid

flow analysis system (cell A6).

Extra

You can also start ANSYS CFD-Post by right-clicking the Results cell and selecting the

Edit... option in the context menu that opens.

The ANSYS CFD-Post application will launch with the extrusion geometry already loaded (displayed in

outline mode). Note that ANSYS POLYFLOW results are also automatically loaded into ANSYS CFD-Post.
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Figure 1.18  The Extrusion Geometry Loaded into ANSYS CFD-Post

2. Obtain the view shown in Figure 1.19 (p. 29).

a. Rotate the view, by holding the center mouse button and moving your pointer in the viewer area.

b. Reduce the magnification of the view by clicking the Zoom icon at the top of the viewer area

( ), holding the left mouse button, and moving your pointer in the viewer area.
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Figure 1.19  Rotating the View

3. Display contours of velocity magnitude on the boundaries (Figure 1.20 (p. 32)).

a. Open the Insert Contour dialog box.

Insert → Contour

b. Retain the default entry of Contour 1 for Name and click OK to close the dialog box.

Information about Contour 1 will be displayed in the Details view below the Tree view in ANSYS

CFD-Post. The Details view contains all of the settings for a contour object.
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c. Open the Location Selector dialog box by clicking the location editor button ( ) next to the

Locations drop-down list in the Geometry tab.
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i. Select all of the boundaries listed under ext3d by clicking the first one in the list (i.e.,

PART_1_1_SOL_DIE_WALL), holding the Shift key, and clicking the last one in the list (i.e.,

PART_1_2_SOL_SYMMETRY_2).

ii. Click OK to close the Location Selector dialog box.

d. Select VELOCITIES from the Variable drop-down list.

e. Click Apply.

The velocity is 0 along the die wall (as expected) and there is a fully developed profile at the inlet of

the die. At the die outlet, the velocity profile changes to become constant throughout the extrudate

cross section. The transition between these two states can be seen in the first third of the extrudate.
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Figure 1.20  Contours of Velocity Magnitude

4. Display contours of velocity in cross sections (Figure 1.21 (p. 37)).

a. Disable Contour1 under User Locations and Plots in the Outline tab of the Tree view.
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b. Create a cross section plane at =�  m.

i. Select Plane from the Location drop-down menu, located in the toolbar.

ii. Retain the default entry of Plane 1 for Name in the Insert Plane dialog box that opens, and

click OK.

Information about Plane 1 will be displayed in the Details view.
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iii. Retain the default selection of XY Plane for Method in the Geometry tab of the Details

view for Plane 1.

iv. Retain the default entry of 0.0 m for Z.

v. Click Apply

c. In a similar manner, create cross section planes at =�  m,  m, and  m named Plane

2, Plane 3, and Plane 4 respectively. Note that you will retain the default selection of XY Plane

for Method and enter appropriate values for Z in the Details view.

d. Disable Plane 1, Plane 2, Plane 3, and Plane 4 under User Locations and Plots in the Outline

tab of the Tree view, so that the planes are no longer colored gray in the viewer area.

e. Open the Insert Contour dialog box.

Insert → Contour

f. Retain the default entry of Contour 2 for Name and click OK to close the dialog box.

Information about Contour 2 will be displayed in the Details view below the Tree view.
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g. Open the Location Selector dialog box by clicking the location editor button ( ) next to the

Locations drop-down list in the Geometry tab.
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i. Select all of the planes listed under User Locations and Plots by clicking Plane 1, holding

the Shift key, and clicking Plane 4.

ii. Click OK to close the Location Selector dialog box.

h. Select VELOCITIES from the Variable drop-down list.

i. Click Apply.

Velocity profiles at the flow inlet, the flow outlet, and planes just before and just after the die exit are

displayed. Compare the velocity profile within the die to the velocity profile just after the die exit at

the end of the computational domain. In the die the flow is fully developed. The velocity profile is flat

(i.e., all the particles in the cross section are at the same velocity) in the extrudate, far away from the

die exit. In the transitional zone just beyond the die exit, the velocity profile is reorganized. The velocity

profile on the plane =�  m is no longer fully developed, but it is not yet flat either. The velocity

rearrangement is the source of the deformation of the extrudate.
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Figure 1.21  Velocity Profiles at Cross Sections

5. Create an expression for the maximum velocity at the flow exit, which can be used as an output

parameter in ANSYS Workbench.

a. Click the Expressions tab in the Tree view.

b. Right-click anywhere in the Expressions tab and click New ... in the menu that opens to create

a new expression.

The New Expression dialog box will open.

i. Enter maxvelocity for Name.
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ii. Click OK to close the New Expression dialog box.

c. Right-click in the Definition tab of the Details view, move your pointer over Functions, move

your pointer over CFD-Post, and click maxVal, to specify that the function in the expression obtains

the maximum value.

d. Make sure that the cursor is between the parentheses of maxVal ()@, right-click in the Details

view again, move your pointer over Variables, and click VELOCITIES, to specify that the variables

obtained in the expression are velocities.
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e. Move the cursor so that it is after the @ symbol of maxVal (VELOCITIES )@, right-click in the Details

view again, move your pointer over Locations, and click PART_1_2_SOL_OUTLET, to specify that

the variables are obtained for the expression at the flow exit.
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f. Click Apply.

The expression in the Definition tab of the Details view will be defined as maxVal (VELOCITIES)@

PART_1_2_SOL_OUTLET with a Value of approximately 7.8 X 10-4 m/s, and maxvelocity

will be added to the list in the Expressions tab of the Tree view, as shown in Figure 1.22 (p. 41).
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Figure 1.22  Creating an Expression for an Output Parameter

g. Right-click on maxvelocity in the Expressions tab of the Tree view and select Use as Workbench

Output Parameter in the context menu that opens.
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An outbound arrow will be added from the Parameters cell to the Parameter Set bar in the

Project Schematic, indicating that an output parameter has been created.

6. Close the ANSYS CFD-Post application.

Note

Note that the ANSYS CFD-Post state files are automatically saved when you exit ANSYS

CFD-Post and return to ANSYS Workbench.

7. Save the ext3d-wb project in ANSYS Workbench.

File → Save

8. View the files generated by ANSYS Workbench, as displayed in the Project Schematic.

Figure 1.23  Displaying the Files View after Viewing Results in ANSYS CFD-Post
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Note the addition of the ANSYS CFD-Post state file (ext3d.cst) to the list of files. For more information

about ANSYS CFD-Post (and the files associated with it), see the ANSYS CFD-Post documentation.

1.4.8. Step 7: Exploring Additional Solutions

At this point you have run the simulation with an initial inlet flow rate. In this step, you will create

multiple design points for various inlet flow rates, solve them with a single action, then review the list

of files generated by ANSYS Workbench.

Note

ANSYS DesignXplorer is licensed separately from ANSYS POLYFLOW. If you do not have access

to ANSYS DesignXplorer, you will not be able to perform some of the steps that follow, such

as computing multiple design points or plotting results in a chart.

1. Open the Parameters and Design Points view (Figure 1.24 (p. 43)).

In the ANSYS Workbench  Project Schematic, double-click the Parameter Set bar below the

ext3d fluid flow analysis system.

Extra

You can also open the Parameters and Design Points view by right-clicking the

Parameter Set bar and selecting the Edit... option in the context menu that opens.

Figure 1.24  The Parameters and Design Points View
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2. Run the calculation again with a new inlet flow rate for the current design point.

a. Enter 8 under P1 - flow rate for the Current design point (i.e., cell B3) in the Table of Design

Points.

An Update Required icon will be added to the cell under P2- maxvelocity for the Current

design point (i.e., cell C3).

b. Right-click on the cell under P2 - maxvelocity for the Current design point and select Update

Selected Design Points in the context menu that opens, to generate the maximum velocity at

the flow exit with the revised inlet flow rate.

Extra

You can also update the design point by clicking Update Project in the ANSYS

Workbench toolbar.

A dialog box will open to inform you that some open editors may close during this process. Click

OK to proceed.

ANSYS POLYDATA will update the data file based on the revised inlet flow rate and ANSYS POLYFLOW will

run again. When the calculation is complete, the Table of Design Points will display a new value of

approximately 6.2 X 10-4 m/s under P2 - maxvelocity for the Current design point.
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3. Create a chart for the updated current design point.

a. Click P1 under Input Parameters (i.e., cell A4) in the Outline of All Parameters.

The ANSYS Workbench  Toolbox will display options for Parameter Charts.

b. Double-click Parameters Chart P1 vs ? in the Toolbox to open the Properties of Outline A11:0

window at the bottom of the Parameters and Design Points view.

The Properties of Outline A11:0 window will display an initial setup for Parameter Chart 0,

in which P1 - flow rate is selected from the X-Axis (Bottom) drop-down list.

c. Select P2-maxvelocity from the Y-Axis (Left) drop-down list in the Properties of Outline A11:0

window.

The current design point will be plotted in Parameter Chart 0 (Figure 1.25 (p. 46)).
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Figure 1.25  The Chart of the Current Design Point

4. Create more design points for a range of inlet flow rates.

a. Enter 10 for P1 - flow rate in the row beneath the Current design point (i.e., cell B*) in the Table

of Design Points, so that a new row is added (4) with DP 1 as the Name.

b. In a similar manner, create additional design points DP 2 and DP 3 with a P1 - flow rate of 11
and 12, respectively.

Extra

You can specify that the data generated for any of the added design points is

saved in a separate project file (e.g., ext3d-wb_dp1.wbpj) by enabling the

Exported option in column D for the design points.

5. Generate the values for the maximum velocity at the flow exit for all of the new design points.

Click Update All Design Points in the ANSYS Workbench toolbar.

ANSYS POLYDATA will update and ANSYS POLYFLOW will run repeatedly to solve for each of the design

points. As each calculation completes, the Table of Design Points (Figure 1.26 (p. 47)) and Parameter

Chart 0 (Figure 1.27 (p. 47)) will be updated.
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Figure 1.26  Displaying Values for All of the Design Points

Figure 1.27  The Chart of All of the Design Points

6. Save the ext3d-wb project in ANSYS Workbench.

File → Save

7. Return to the Project Schematic view by clicking the Return to Project button in the ANSYS Work-

bench toolbar.

8. View the files generated by ANSYS Workbench, as displayed in the Project Schematic.
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Figure 1.28  Displaying the Files View after Exploring Solutions

Note that the list of files shows that the design point file (designPoint.wbdp) was updated. For

more information about the files associated with ANSYS Workbench, see the ANSYS Workbench docu-

mentation.

1.4.9. Step 8: Summary

In this tutorial, portions of ANSYS Workbench were used to simulate a 3D extrusion and to compare

the flow exit velocities associated with a range of inlet flow rates.

ANSYS DesignModeler was used to prepare the geometry, ANSYS Meshing was used to create a compu-

tational mesh, ANSYS POLYDATA was used to set up the simulation, ANSYS POLYFLOW was used to

calculate the fluid flow throughout the geometry using the computational mesh, and CFD-Post was

used to analyze the results. In addition, the Parameters and Design Points view of ANSYS Work-

bench was used to add additional design points and compare their associated flow exit velocities on a

chart.
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